
 

 

Installation Instructions for Hot Fix F90013 
 

Windows for x64 

 

NOTE: Both F90013 and F12014 hot fixes must be installed using the information 

provided below.  

 
  F12014 is a stand-alone hot fix for SAS Risk Management for Insurance Server 2.1_M1. 
 

F90013 is a "container" hot fix that contains the following "member" hot fixes that will 
update the software components as indicated. See the Container Hot Fixes section in the 
Maintenance Install Tool (MIT) Usage Guide for more information about container hot fixes. 

 

G55011 for SAS Detail Data Store for Insurance 5.4_M1 

F88013 for SAS Firmwide Risk Management for Insurance Server 2.1_M1 

F89013 for SAS Market Risk Management for Insurance Server 2.1_M1 

G54011 for SAS Risk Reporting Repository 1.4_M1 
F92013 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1 

F91013 for SAS Underwriting Risk Management for P&C Insurance Server 2.1_M1 
G61010 for SAS Risk Management for Insurance Mid-Tier 2.1_M1 

 
Before applying these hot fixes, follow the instructions in SAS Note 35968 to generate a SAS 

Deployment Registry report, and then verify that the appropriate product releases are installed 

on your system. The software components and release numbers should match the list of 

software components updated by the individual hot fix installers. 
 

IMPORTANT NOTES 

 

1. Hot fix F04002 for SAS Risk Dimensions 5.3_M1 is required prior to installing this hot fix.  

 

http:\\ftp.sas.com\techsup\download\hotfix\HF2\F04.html#F04002  
 

2. It is advised to install also Hot fix C63005 for SAS Data Integration Studio 4.2. There 

have been reports of missing job properties when importing the DIRR DI job package (see 

further) 

 

http:\\ftp.sas.com\techsup\download\hotfix\HF2\B51.html#41044 

 

3. Files delivered in this hot fix will be backed up during the installation process. 

However, it is good general practice to back up your system before applying updates to 

software. 

 
4. When applying these hot fixes, you MUST use the -silent and the -alwaysoverwrite  

options. ANY customizations that may have been made to files included in the hot fix will be 

lost. The hot fix installer will automatically back up files for you. After the hot fix has been 

installed, use the backup copies to merge any of the customizations that you wish to retain. 

Links to manifests are provided in the section below to assist in determining which files will 

be overwritten. 

http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://support.sas.com/kb/35/968.html
http://ftp.sas.com/techsup/download/hotfix/HF2/F04.html#F04002
http://ftp.sas.com/techsup/download/hotfix/HF2/B51.html#41044


 

 

 

 
5. Take backups of all .spk files prior to importing newer versions or making any updates to 

the contents of an existing .spk file. This can be done by first logging into the SAS 
Management Console (SMC) using the Administrator (sasadm) user, navigating to the 
appropriate folder containing metadata and exporting the folder contents to a uniquely 
named .spk file. 

 
6. Configurations and related uncompiled macro files for the following reports will be 

updated in this install: 
 

 ASSETS-D1  

 ASSETS-D1Q  

 ASSETS-D1S 

 ASSETS-D2O 

 ASSETS-D2T 

 ASSETS-D3 

 ASSETS-D4 

 ASSETS-D5 

 ASSETS-D6  

 BS- C1 

 BS-C1D  

 DurLiab 

 Country-K1 

 Cover-A1A                                          

 Cover-A1Q 

 G01 

 G03 

 G04 

 IGT1 

 IGT2  

 IGT3 

 IGT4 

 Lapses 

 MCR-B4A  

 MCR-B4B  

 OF-B1Q 

 P&L 

 RC 

 RE-J1 Basic  

 RE-J1 Shares  

 RE-J2 Basic  

 RE-J2 Shares  

 REJ2 Group 

 RE-J3 

 RE-SPV  

 SCR-B2A 



 

 

 SCR-B2A_B2C  

 SCR-B2B 

 SCR-B2C  

 SCR-B3A 

 SCR-B3B 

 SCR-B3C  

 SCR-B3D  

 SCR-B3E 

 SCR-B3G 

 TP-E1 

 TP-E1Q  

 TP-E2  

 TP-E3 

 TP-E4 

 TP-E6 

 TP-E7A  

 TP-E7B  

 TP-F1 

 TP-F1Q 

 TP-F2 

 TP-F3 

 TP-F3A  

 TP-F3B  

 TP-F4 

 VA-C2A  

 VA-C2B 

 VA-C2C 

 
The following reports from the above list have been migrated to the EIOPA provided CP 11 

Final QRT templates: 

 
 Assets-D1 

 Assets-D1Q  

 Assets-D1S 

 Assets-D2O  

 Assets- D2T  

 Assets-D3 

 Assets-D4 

 Assets-D5 

 Assets-D6  

 BS- C1 

 BS-C1D 

 Country-K1 

 Cover-A1A  

 Cover-A1Q 

 DurLiab 



 

 

 G01 

 G03 

 G04 

 IGT1 

 IGT2  

 IGT3 

 IGT4 

 Lapses 

 MCR-B4A  

 MCR-B4B 

 OF-B1Q  

 P&L 

 RC 

 RE-J1 Basic 

 RE-J1 Shares 

 RE-J2 Basic 

 RE-J2 Shares  

 RE-J2 Group 

 RE-J3 

 SCR-B2A 

 SCR-B2A_B2C  

 SCR-B2B 

 SCR-B2C 

 SCR-B3A  

 SCR- B3C  

 SCR-B3E  

 SCR-B3G 

 TP-E1 

 TP-E1Q  

 TP-E2 

 TP-E3 

 TP-E4 

 TP-E7A 

 TP-E7B  

 TP-F1 

 TP-F1Q  

 TP-F2 

 TP-F3 

 TP-F3A  

 TP-F3B  

 TP-F4 

 VA-C2B 

 VA-C2C 

 

The following reports, if already existing on your system will not be available after this 

install as the reports have been dropped from the CP 11 Final QRT templates by EIOPA. 



 

 

Metadata and configurations for the reports have been removed: 

 
 Cover-A1 

 C2_ANALYSIS_LF  

 C2_ANALYSIS_NL  

 C2_SUMMARY 

 G10 

 G15 

 G20 

 G30 

 IGT5  

 IGT6 

 TP-E5 

 TP-E7 

 VA-C2D 

 
Following reports were added \ updated in the metadata per CP9 and CP 11 Final EIOPA 

QRT lists: 

 
 Assets-D1Q  

 Assets-D1S 

 Assets-D2O  

 Assets- D2T 

 Cover-A1A 

 Cover-A1Q  

 Duration liabilities  

 Lapses  

 Participations  

 P&L Sharing 

 RE-J1 Basic  

 RE-J1 Shares  

 RE-J2 Basic  

 RE-J2 Shares 

 SCR_B2A_B2C  

 TP-E7A  

 TP-E7B 

 VA-C2A  

 VA-C2B  

 VA-C2C 

 
The following reports from the above list have been added as per the EIOPA provided CP 

13 templates: 

 

 Assets-D1 

o S0602A 

o S0602B 



 

 

o S0602F 

o S0602G 

 Assets-D2O 

o S0801A 

o S0801B 

o S0801F 

o S0801G  

 Own funds B1A 

o S2301B  

o S2301G 

 Own Funds B1Q 

o S2301A 

o S2301F 

 BS-C1 

o S0201A 

o S0201B 

o S0201F 

o S0201G 

 BI (basic information) 

o S0102A  

o S0102B 

o S0102F 

o S0102G 

 SCR-B3G 

o S2606B 

o S2606G 

o S2606L 

o S2606N 

 SCR-B3B 

o S2602B 

o S2602G 

o S2602L 

o S2602N 

 TP-E1 

o S1701B 

 TP-E1Q 

o S1701A 

 SCR-B3D  

o S2604B  

o S2604G 

o S2604L  

o S2604N 

 SCR-B3C 

o S2603B 

o S2603G 

o S2603L 



 

 

o S2603N 

 SCR-B3A  

o S2601B 

o S2601G 

o S2601L 

o S2601N 

 MCR-B4A 

o S2801A 

o S2801B 

 MCR-B4B 

o S2802A 

o S2802B 

 SCR-B3E 

o S2605B 

o S2605G 

o S2605L 

o S2605N 

 SCR-B2A 

o S2501B 

o S2501B 

o S2501L 

o S2501N 

 SCR-B3F 

o S2701B  

o S2701G  

o S2701L 

o S2701N 

 SCR-B2B 

o S2502B 

o S2502G 

 SCR-B2C 

o S2503B 

o S2503G 

 G01 

o S3201G 

 G03 

o S3301G 

 G04 

o S3401G 

 G14 

o S3501G 

 BS-C1D 

o S0202B 

 TP-F1Q 

o S1201A 

 TP-F1 



 

 

o S1201B 

 Content 

o S0101A 

o S0101B 

o S0101F 

o S0101G 

 Validation report 

 
 

 

 
Stored Process (STP) names and descriptions have been updated in the metadata for a 

large majority of the reports to align with changes per CP 9 and CP 11 Final EIOPA 

templates. These updates can be applied to the system by importing reports.spk and 

reports_cp13.spk.  Details of the import process are available in the section Import 

updated .spk files. 

 
If you need to retain previous versions of these files, they can be retrieved from backup 

locations as needed. 

 
7. As part of this install, support for XBRL reporting has been added. In order to support this 

feature, the following changes have been introduced inin the static directory: 

 
Newly added table: 

 XBRL_CONFIGURATION 

 

Deprecated tables 
 

 XBRL_COMPLEXTYPE 

 XBRL_COMPLEXTYPE_ENUMERATION 

 XBRL_DIMENSION  

 XBRL_FACTELEMENTS  

 XBRL_FMT  

 XBRL_REPORT 

 XBRL_SCHEMA 

 
Columns for the newly added table: 

 

 

Table Name Column name 

 



 

 

XBRL_CONFIGURATION CONFIG_SET_ID 

VALID_FROM_DTTM 

XBRL_CONFIG_NM  

VALID_TO_DTTM  

XBRL_CONFIG_VALUE 

XBRL_CONFIG_DESC 

 
New columns added to existing tables: 

 
Table Name Column name 

 
REPORT_CONFIGURATION FREQUENCY_CD 

XBRL_FILING_ID 

REPORT_FACT_DATA_MAP REPORT_CELL_ID 

REPORT_DS_STRUCTURE REPORT_CELL_ID 

 
 
8. You must have Administrator Privileges on your CLIENT or SERVER machine. 

9. All currently active SAS sessions, daemons, spawners and servers must be terminated 

before applying this hot fix. 

10. This hot fix should be installed using the same userid that performed the initial software 

installation. 

11. On UNIX systems, you may need to adjust file permissions on all new and updated files to 

meet with your sites security guidelines. 

12. Before commencing the installation, please check the RMI wiki for any post release PUP14 

updates: http://smteam.sas.com/psd/rmi/phoenix/RMI%20wiki/Product%20Update%20Pack

%2014.aspx 

 
 

INSTALLATION 

 
This hot fix must be installed on each machine where the updated components of the 

product, listed above, are installed. The installation process will determine which 

components of SAS Risk Management for Insurance 2.1_M1 are installed on each 

machine, and apply the appropriate updates. 
 

If the updated components of this product are installed on multiple operating systems, you 

must download the hot fix for the appropriate operating system(s) and follow the installation 

instructions provided to complete the deployment of this hot fix. 

 
The installer downloaded is F90013x6.exe. 

 
When downloading SAS 9.2 hot fix packages, you must choose to Save the hot fix to disk, and 

http://smteam.sas.com/psd/rmi/phoenix/RMI%20wiki/Product%20Update%20Pack%2014.aspx
http://smteam.sas.com/psd/rmi/phoenix/RMI%20wiki/Product%20Update%20Pack%2014.aspx


 

 

then execute the install from the saved location. Attempting to install a hot fix directly from 
the download page results in the error documented in SAS Note 37104. 

 

 To install this hot fix execute: 

 F90013x6.exe using both the -alwaysoverwrite and –silent options. 

 F12014x6.exe using both the -alwaysoverwrite and –silent options. 

 
This will initiate the installation wizard, which will guide you through the hot fix 

installation process. 

 
Note: If your Windows operating system is Windows Vista, Windows 7 or Windows Server 

2008, it may be necessary to install with the “Run as administrator” option. Within the 

Start menu’s Accessories folder, right-click the Command Prompt shortcut, and select 

“Run as Administrator” option. Next execute F90013x6.exe using the -alwaysoverwrite 

option. 

 
See the Maintenance Install Tool (MIT) Usage Guide  for more details on the installation of 

hot fixes. The content of this hot fix is listed in the hot fix manifest. This completes the 

installation of F90013 and F12014. You must perform any "Post-Installation Instructions" 

documented below to successfully complete the deployment of this hot fix. 
 

 

POST-INSTALLATION INSTRUCTIONS 
 

 
G55011 for SAS Detail Data Store for Insurance 5.4_M1 

F88013 for SAS Firmwide Risk Management for Insurance Server 2.1_M1 

F89013 for SAS Market Risk Management for Insurance Server 2.1_M1 

F12014 for SAS Risk Management for Insurance Server 2.1_M1 

G54011 for SAS Risk Reporting Repository 1.4_M1 

F92013 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1 

F91013 for SAS Underwriting Risk Management for P&C Insurance Server 

G61010 for SAS Risk Management for Insurance Mid-Tier 2.1_M1 
 

G55011 for SAS Detail Data Store for Insurance 5.4_M1 

 
1. If you have existing DDS physical tables, take a backup of the data in a different location. 

2. Following is the summary of the changes in this hot fix: 

 

 

Newly added tables: 

 
 ACCOUNTING_TRANS  

 ACCOUNTING_TRANS_LINE_ITEM  

 ACCOUNT_PERIOD  

 ACCOUNT_PERIOD_ASSOC  

 ASSET_PORTFOLIO_SEGMENT  

http://support.sas.com/kb/37/104.html
http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://ftp.sas.com/techsup/download/hotfix/HF2/F/F90/F90011/xx/lax/F90010la_manifest.html


 

 

 ASSET_SEGMENT_X_EXPOSURE  

 BUSINESS_ENTITY 

 CEDED_LOSS  

 CLAIM_INJURED  

 CLAIM_UNIT_X_INJURED  

 CONTRACT_SECTION_X_RI_CARRIER  

 CREDIT_FACILITY_CR_MITIGANT  

 CURRENCY_CONVERSION_RATE  

 EXPOSURE_PLEDGED  

 EXTERNAL_ORG_INDUSTRY_CLASS  

 FRA_INSURMENT_LEG  

 GL_SEGMENT_BALANCE  

 GL_SEGMENT_PARAMETER  

 GL_SEGMENT_PARAM_GROUP  

 REINSURANCE_COLLATERAL  

 REINSURANCE_CONTRACT  

 REINSURANCE_CONTRACT_SECTION  

 REINSURANCE_COVERAGE  

 REINSURANCE_COVERAGE_REFERENCE  

 REINSURANCE_INTERMEDIARY  

 REINSURANCE_PROGRAM  

 REINSURANCE_RATE  

 REINSURANCE_REINSTATEMENT  

 RISK_DRIVER  

 RISK_DRIVER_X_EXPOSURE  

 RI_TRANS_X_CEDED_LOSS 

 SUB_LEDGER  

 SUB_LEDGER_BALANCE  

 TRADE 

 XL_LAYER  

 XL_LAYER_X_RI_CARRIER 
 

  



 

 

Newly added columns: 

 
Table Name Column Name 

ASSET_SEGMENT_X_EXPOSURE FINANCIAL_POSITION_RK 

BOND_INSTRUMENT PRINCIPAL_EXCHANGE_FLG 

                          CONVERTIBLE_FLG 
 

CEDED_LOSS CEDED_LOSS_AMT_CHANGE_DTTM 

 
CLAIM_UNIT CLAIM_UNIT_CURRENCY_CD 

RECOVERY_ESTIMATED_AMT 

RECOVERY_RECEIVED_AMT 

APPLICATION_RK 

 
COMML_PROP_DETAILS APPLICATION_RK 

 
COMML_VEHICLE_DETAILS  CEDED_LOSS 

CONTRACT_SECTION_X_RI_CARRIER          ANNOTATION_TXT 

CONVERSION_SCHEDULE  VALID_FROM_DTTM 

VALID_TO_DTTM 

 
COUNTERPARTY  MIN_CAPITAL_REQ_FLG 

SINGLE_NAME_EXPOSURE_FLG 

 SSOLVENCY2_STANDARD_ID 

 
COVERED_PERILS PERIL_RK 

 
CREDIT_FACILITY CIC_CD UNWIND_MAX_LOSS_AMT 

UNWIND_TRIGGER_EVENT_TYPE_CD 

 

CREDIT_RISK_MITIGANT PRIM_COLL_ASSET_TYPE_CD 

 
EMBEDDED_OPTIONS EMBED_OPT_SCHEDULE_LOOKUP_FLG 

 
FINANCIAL_ACCOUNT CIC_CD 

INT_PAYMENT_DAY_OF_MONTH_NO 

PAYMENT_DAY_OF_MONTH_NO 

PREPMT_PSA_SPEED_RT 

RESET_DAY_OF_MONTH_NO 

UNWIND_MAX_LOSS_AMT 

UNWIND_TRIGGER_EVENT_TYPE_CD 

 
FINANCIAL_FUND PROFIT_PARTICIPATION_PCT 

 DERIVATVE_HELD_LINKED_FUND_FLG 

 
FINANCIAL_INSTRUMENT CIC_CD 

INT_PAYMENT_DAY_OF_MONTH_NO 

PAYMENT_DAY_OF_MONTH_NO 

RESET_DAY_OF_MONTH_NO 

UNWIND_MAX_LOSS_AMT 

UNWIND_TRIGGER_EVENT_TYPE_CD 



 

 

FINANCIAL_INSTRUMENT_ASSOC PHYSICAL_ASSET_RK 

FINANCIAL_INSTRUMENT_CHNG PREM_PAID_PERIOD_TO_DATE_AMT 

SWAP_INFLOW_PERIOD_TO_DATE_AMT 

SWAP_OUTFLW_PERIOD_TO_DATE_AMT 

SWAP_DELIVERED_CURRENCY_CD 

SWAP_RECEIVED_CURRENCY_CD 

 
FINANCIAL_POSITION CUSTODIAN_COUNTERPARTY_RK 

FUND_INSTRUMENT LEVEL_OF_LOOKTHROUGH_CD 

DELTA_RT 

GENERAL_UNIT_OF_EXPOSURE                  UNDERWRITING_MODEL_AMT 

    UNDERWRITING_MODEL_TYPE_CD 
 

GL_ACCOUNT CONTROL_ACCOUNT_FLG 

 
GL_ACCOUNT_BALANCE  ACCOUNT_PERIOD_RK AS_OF_DATE 

GL_BALANCE_BASE_CURRENCY_CD 

GL_BALANCE_REPT_CURRENCY_CD 

REPORTING_METHOD_CD 

TAX_RT 

 

GL_SEGMENT_BALANCE  AS_OF_DT 

 TAX_RT 

 
GL_JRNL REVERSAL_DESC 

REVERSAL_REASON_CD 

REVERSED_GL_JRNL_ID 

 
GL_JRNL_DETAILS ACCOUNT_PERIOD_RK 

GL_SEGMENT_PARAM_GROUP GL_SEGMENT_GROUP_DESC 

GL_SEGMENT_PARAMETER PARAMETER_DESC 

INDIVIDUAL DECEASED_DT 

 
LEGAL_PROT_INSURED_SUBJECT APPLICATION_RK 

LIABILITY_INSURED_SUBJECT APPLICATION_RK 

OTHER_INSURED_SUBJECT                          APPLICATION_RK 

PERIL PERIL_RK 

                  VALID_FROM_DTTM   

                  VALID_TO_DTTM 

 
PERS_PROP_DETAILS APPLICATION_RK 

 
PERS_VEHICLE_DETAILS APPLICATION_RK 

 
PHYSICAL_ASSET CIC_CD 



 

 

 
PORTFOLIO ASSET_PORTFOLIO_SEGMNT_TYPE_CD 

 

REINSURANCE_CARRIER  PARTICIPATION_LIMIT_AMT 

RI_CARRIER_RK 

RI_CARRIER_TYPE_CD 

RI_NETWORK_ID 

 
REINSURANCE_COLLATERAL EFFECTIVE_DTTM 

 EXPIRATION_DTTM 

REINSURANCE_CONTRACT_SECTION GROSS_RETENTION_PCT 

REINSURANCE_EXPOSURE CEDING_COMMISSION_AMT 

RI_AMT_SHARE 

RI_CONTRACT_SECTION_RK 

RI_EXP_EFFECTIVE_DT 

RI_EXP_EXPIRATION_DT 

 
REINSURANCE_TRANS RI_CONTRACT_RK 

RI_CONTRACT_SECTION_RK 

RI_REINSTATEMENT_RK 

XL_LAYER_RK 

 
REINSURANCE_TRANS_LINE_ITEM LINE_ITEM_TRANS_AMT 

RI_CONTRACT_RK 

RI_CONTRACT_SECTION_RK 

 
REPO_INSTRUMENT COLLATERAL_TYPE_CD 

 ROLLOVER_STRATEGY_ID 

 

RF_CURVE_X_RF_GROUP VALID_FROM_DTTM 

VALID_TO_DTTM 

RI_TRANS_X_RI_EXPOSURE RI_CONTRACT_RK 

RI_EXP_TRANS_AMT 

 
RISK_FACTOR VALID_FROM_DTTM 

VALID_TO_DTTM 

 
RISK_FACTOR_CURVE VALID_FROM_DTTM     

VALID_TO_DTTM 

 
RISK_FACTOR_GROUP VALID_FROM_DTTM   

VALID_TO_DTTM 

 
RSK_FCTR_X_ANAL_MDL_TRANS_METH VALID_FROM_DTTM 

                              VALID_TO_DTTM 

 
RISK_FACTOR_X_RISK_FCTR_CURVE VALID_FROM_DTTM 

                             VALID_TO_DTTM 

 
SECURITIZATION_INSTRUMENT PREPAY_STRUCTURED_PRODUCT_FLG 

 

SECURITIZATION_POOL  RESECURITIZATION_FLG 

UNDERLYING_PRODUCT_TYPE_CD 

 UNDERLYING_COLLATERAL_TYPE_CD 



 

 

 
SUB_LEDGER AS_OF_DT 

 
SWAP_INSTRUMENT_LEG   PAYMENT_DAY_OF_MONTH_NO 

 INT_PAYMENT_DAY_OF_MONTH_NO  

 RESET_DAY_OF_MONTH_NO 

 
TECHNICAL_INSURED_SUBJECT APPLICATION_RK 

 
XL_LAYER CAP_RANGE_1_AMT_TYPE_CD 

CAP_RANGE_2_AMT_TYPE_CD 

DEDUCTIBLE_1_AMT 

DEDUCTIBLE_2_AMT 

LIMIT_1_AMT LIMIT_2_AMT 

 
XL_LAYER_X_RI_CARRIER  ANNOTATION_TXT 

 
Renamed Columns: 

 
The column ASSET_PORTFOLIO_X_EXPOSURE_RK from 

ASSET_PORTFOLIO_SGMNT_X_EXPOSURE table had a typo. The column has been 

renamed to ASSET_PORTFOLIO_X_EXPOSURE_RK. 

 
Deprecated tables and columns: 

 
A few tables and columns were deprecated from previous versions. They are now 

physically removed. 

 
Deprecated Tables 
 

CLAIM_INJURED_DETAILS 

REINSURANCE_CLAIM 

REINSURANCE_TREATY 

REINSURER_X_TREATY 

RI_TREATY_X_COVERAGE 

RI_TREATY_X_PERILS 

SCHEDULE_X_TREATY 

 

Deprecated Columns 

 
Table Name. Column Name 

 
ASSET_SEGMENT_X_EXPOSURE. FINANCIAL_INSTRUMENT_RK 

BOND_VOLATILITY_QUOTE. TERM_CD  

COMMODITY_VOLATILITY_QUOTE. TERM_CD 



 

 

COVERED_PERILS  .PERIL_CD 

 
CREDIT_SPREAD_QUOTE. TERM_CD 

 
FX_FORWARD_QUOTE. TERM_CD 

 
FX_VOLATILITY_QUOTE. TERM_CD 

 
INDEX_VOLATILITY_QUOTE. TERM_CD 

 
INTEREST_RATE_QUOTE. TERM_CD 

 
INT_RATE_VOLATILITY_QUOTE TERM_CD       
UNDERLYING_TERM_CD 

 
PHYSICAL_ASSET_QUOTE TERM_CD 

 
REINSURANCE_CARRIER PARTICIPATION_LIMIT  

REINSURANCE_CARRIER_CD 
REINSURANCE_NETWORK_ID  

REINSURER_RK 

 
REINSURANCE_COLLATERAL  EFFECTIVE_DT 

EXPIRATION_DT 

 
REINSURANCE_EXPOSURE  CESSION_LOWER_AMT 

CESSION_TYPE_CD 

CESSION_UPPER_AMT 

CURRENCY_CD 

FACULTATIVE_REINSURER_RK 

REINSURED_AMT_TYPE_CD 

RETENTION_AMT RI_EFFECTIVE_DT 

RI_EXPIRATION_DT 

RI_PREMIUM_BASIS_CD 

RI_RISK_BASIS_CD TREATY_RK 

ULTIMATE_CEDED_AMT 

 
REINSURANCE_TRANS  TREATY_RK 

 

REINSURANCE_TRANS_LINE_ITEM TREATY_RK 

RI_TRANS_X_RI_EXPOSURE TREATY_RK 

 
Columns with changed attributes: 

 
Table Name Column Name 

 
ACCOUNT_PERIOD_ASSOC ORDER_NO 

 
CEDED_LOSS CEDED_LAE_CASE_RESERVE_AMT 

CEDED_PAID_LAE_AMT 

 
CURRENCY_CONVERSION_RATE CONVERSION_RT 

 



 

 

 
EXTERNAL_ORG NAICS_CD 

SIC_CD 

 
FINANCIAL_INSTRUMENT FINANCIAL_INSTRUMENT_NM 

 
FUND_INSTRUMENT LEVEL_OF_LOOKTHROUGH_CD 

 
INDEX_QUOTE INDEX_CD 

 
INTERNAL_ORG NAICS_CD 

SIC_CD 

 
MARKET_DATA DATA_DTTM 

 
REINSURANCE_CONTRACT CEDENTS_CONTRACT_ID 

REINSURANCE_CONTRACT_SECTION MAX_COVER_PER_RISK_EVENT 

REINSURANCE_EXPOSURE  RI_PREMIUM_DUE_DT 

RI_PREMIUM_PAID_TO_DT 

 
RISK_FACTOR_X_RISK_FCTR_CURVE VALID_TO_DTTM 

RSK_FCTR_X_ANAL_MDL_TRANS_METH CURR_NUM_UNITS 

UNIT_OF_MEASURE UOM_TYPE_DESC 

 

1. If you already have existing DDS physical tables, execute the ddls of the tables that have 

undergone changes as mentioned in point 2 above from the 

<SASHOME>\SASFoundation\9.2\insurancedds\sasmisc\insurancedds_5.4M1\ddl\sas 

folder. 
 

2. If you do not have existing DDS physical tables, execute the ddlgen.sas file present in 

<SASHOME>\SASFoundation\9.2\insurancedds\sasmisc\insurancedds_5.4M1\ddl\sas 

folder. 
 

3. If you already have existing DDS physical tables, migrate data for those tables which are 

updated in this hot fix. 

4. Copy the files present in 

<SASHOME>\SASFoundation\9.2\sasmisc\insurancedds\insurancedds_5.4M1\metadata

\ folder to a location that can be accessed by DI studio client. 
 

5. Open DI studio and logon as unrestricted user. 
 

6. If you have existing metadata for DDS, backup the same. 
 

7. If you do not have existing metadata for DDS, import 

insurancedds_54m1_sas.spk followed by insurancedds_54m1_hf1_sas.spk, 

insurancedds_54m1_hf2_sas.spk, insurancedds_54m1_hf3_sas.spk, 

insurancedds_54m1_hf4_sas.spk, and insurancedds_54m1_hf5_sas.spk, 

insurancedds_54m1_hf6_sas.spk and insurancedds_54m1_hf7_sas.spk, 

insurancedds_54m1_hf8_sas.spk and insurancedds_54m1_hf9_sas.spk. 



 

 

 
Note that before importing the insurancedds_54m1_hf2_sas.spk, please delete the table 

SCHEDULE_X_TREATY from the destination metadata server using DI Studio from the 

folder \Products\SAS Detail Data Store For Insurance\DDS5.4_M1\01 INSURANCE 

PRODUCT. 

 
8. If you have existing metadata for DDS hot fix1, 2, 3, 4, 5, 6, 7 and 8 on top of 5.4M1, 

import insurancedds_54m1_hf9_sas.spk. 

 
a. Notes: 

 

b. Once all hot fixes have been installed, execute the below code in DI Studio to 

delete the metadata for the physically removed tables\columns. The code 

below will synchronize table\column metadata as per physical table 

structures. 
 

In DI Studio, start the code editor from “Tools” menu and execute below code 

with appropriate values of parameters: 

 
options  

   metaserver = "<metadata server>"  

   metauser = "<metadata user id>" 

   metapass = "<password for metadata user>" 

   metaport = <port number> 

   metaprotocol = bridge  

   metarepository = "Foundation"  

; 

proc metalib; 

   omr (library = "Detail Data Store" repname = "Foundation");  

   update_rule (delete); 

   report; 

run; 

 
For detailed instructions on creating physical table and importing metadata, please refer to 

SAS® Detail Data Store for Insurance 5.4 Second Edition. 

 

F88013 for SAS Firmwide Risk Management for Insurance Server 2.1_M1 

 
1) You should delete (or rename) the file rmif_pm_cpty_risk.sas found in 

SASFoundation\9.2\rmifirmmva\ucmacros folder. This file has been incorrectly delivered to 

this location. In this package, the most recent version of this file will be correctly delivered 

to the following location:  

misc\rmifirmmva\solution_data_mart\fw_env\methods.  

2) You should delete (or rename) the files rmif_bat_run_oprisk.sas and 

rmif_enrich_oprisk_source.sas found in SASFoundation\9.2\rmicomnsvr\ucmacros folder. 

These files has been incorrectly delivered to this location. In this package, the most recent 

version of these files will be correctly delivered to the following location:  

SASFoundation\9.2\rmifirmmva\ucmacros 

 

 

F89013 for SAS Market Risk Management for Insurance Server 2.1_M1 

 



 

 

  NONE 
 
 

F12014 for SAS Risk Management for Insurance Server 2.1_M1 

 
Import updated .spk files: 

 
1. Backup existing metadata. 

 
2. Import delivered SPK files using SAS MC Import\Export SAS Package wizard 

 
a. Import updated analysis.spk for Firmwide Risk Server 2.1 

 
i. Login to SAS Management Console (SMC) as the Administrator 

(sasadm) user 

ii. Click on the Folders tab 

iii. Navigate to the folder Analysis under System -> Applications -> SAS 

Risk Management for Insurance -> Firmwide Risk Server 2.1 

iv. Next, right-click on the Analysis folder and select Import SAS Package 
from the menu 

v. Browse to 

<SASHOME>\SASFoundation\9.2\rmifirmmva\sasmisc\Config\Deploy

ment\Packages and select the analysis.spk file. 

vi. Select the radio button for All Objects and click Next. 

vii. You should see a list of STPs in the window. Click Next and then Next again. 

viii. Ensure that you have the correct mappings for the SAS Application 

Servers. 
Click Next. 

ix. On this screen, map source code repositories between original and 

target application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmifirmmva\sasstp\ folder. Click Next. 

x.  Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier 

steps. 

xi. The next screen should show that the import was completed. Click 

the View Log button and scan the log for any errors. If the import 

was successful, you should see messages such as “The import 

process completed successfully” in the log. 

xii. Click Ok and then Finish. 

 

 

b. Import updated configuration.spk for FIRMWIDE Risk Server 2.1  
 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) user  

ii. Click on the Folders tab  

iii. Navigate to the folder Configuration under System -> Applications -> SAS Risk 

Management for Insurance -> Firmwide Risk Server 2.1  



 

 

iv. Select all the STPs, right-click and select Delete.  

v. Ensure that all STPs have been deleted from the Configuration folder.  The group 

solvency stored process configuration has been removed.  

vi. Next, right-click on the Configuration folder and select Import SAS Package 

from the menu  

vii. Browse to 

<SASHOME>\SASFoundation\9.2\rmifirmmva\sasmisc\Config\Deployment\Pac

kages and select the configuration.spk file.  

viii. Select the radio button for All Objects and click Next.  

ix. You should see a list of STPs in the window. Click Next and then Next again. 

x. Ensure that you have the correct mappings for the SAS Application Servers.  

xi. Click Next.  

xii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmifirmmva\sasstp\ folder. Click Next.  

xiii. Review the Summary information and click Next if correct.  Otherwise, click on 

the Back buttons to make necessary corrections in earlier steps.  

xiv. The next screen should show that the import was completed. Click the View Log 

button and scan the log for any errors. If the import was successful, you should 

see messages such as “The import process completed successfully” in the log.  

xv. Click Ok and then Finish.  

 

c. Import updated analysis.spk for Life Risk Server 2.1  
 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 
user 

ii. Click on the Folders tab 

iii. Navigate to the folder Analysis under System -> Applications -> SAS Risk 

Management for Insurance -> Life Risk Server 2.1 

iv. Select all the STPs, right-click and select Delete. Ensure that all STPs have 

been deleted from the Analysis folder. The reason these STPs need to be 

deleted is that a parameter, RR_INPUTS has been added to most of the STPs. 

The parameter can be seen by expanding the System parameter group on the 

Parameters tab. You should also see a new STP, SLTH_SOLVENCY if not 

already added in a prior hotfix install. 

v. Next, right-click on the Analysis folder and select Import SAS Package 

from the menu 

vi. Browse to 

<SASHOME>\SASFoundation\9.2\rmilifemva\sasmisc\Config\Deployment 

\Packages and select the analysis.spk file. 

vii. Select the radio button for All Objects and click Next 

viii. You should see a list of STPs in the window. Click Next and then Next 

again. 

ix. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

x. On this screen, map source code repositories between original and target 



 

 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmilifemva\sasstp folder. Click Next. 

xi. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

xii. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see messages such as “The import process 

completed successfully” in the log. 

xiii. Click Ok and then Finish. 

 

 

d. Import updated analysis.spk for Market Risk Server 2.1  
 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 
user 

ii. Click on the Folders tab 

iii. Navigate to the folder Analysis under System -> Applications -> SAS Risk 

Management for Insurance -> Market Risk Server 2.1 

iv. Select all the STPs, right-click and select Delete. Ensure that all STPs have 

been deleted from the Analysis folder. The reason these STPs need to be 

deleted is that a parameter, RR_INPUTS has been added to most of the STPs. 

The parameter can be seen by expanding the System parameter group on the 

Parameters tab. 

v. Next, right-click on the Analysis folder and select Import SAS Package 

from the menu 

vi. Browse to 

<SASHOME>\SASFoundation\9.2\rmimktmva\sasmisc\Config\Deployment\P

ackages and select the analysis.spk file. 

vii. Select the radio button for All Objects and click Next 

viii. You should see a list of STPs in the window. Click Next and then Next 

again. 

ix. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

x. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmimktmva\sasstp folder. Click Next. 

xi. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

xii. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see messages such as “The import process 

completed successfully” in the log. 

xiii. Click Ok and then Finish. 

 

e. Import updated analysis.spk for Property Casual Risk Server 2.1 
 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 



 

 

user 

ii. Click on the Folders tab 

iii. Navigate to the folder Analysis under System -> Applications -> SAS Risk 

Management for Insurance -> Property Casual Risk Server 2.1 

iv. Select all the STPs, right-click and select Delete. Ensure that all STPs have 

been deleted from the Analysis folder. The reason these STPs need to be 

deleted is that a parameter, RR_INPUTS has been added to most of the STPs. 

The parameter can be seen by expanding the System parameter group on the 

Parameters tab. You should also see a new STP, NSLTH_SOLVENCY if not 

already added in a prior hotfix install. 

v. Next, right-click on the Analysis folder and select Import SAS Package 

from the menu. 

vi. Browse to 

<SASHOME>\SASFoundation\9.2\rmipcmva\sasmisc\Config\Deployment\Pac

kages and select the analysis.spk file. 

vii. Select the radio button for All Objects and click Next. 

viii. You should see a list of STPs in the window. Click Next and then Next 

again. 

ix. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

x. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmipcmva\sasstp folder. Click Next. 

xi. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

xii. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see messages such as “The import process 

completed successfully” in the log. 

xiii. Click Ok and then Finish. 

 
f. Import updated reports.spk for the RMI Common Server component 

 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user 
 

ii. Click on the Folders tab 

iii. Navigate to the folder Reports under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1 

iv. Select all the Reports, right-click and select Delete. Ensure that all Reports 

have been deleted from the Reports folder. 

v. Next, right-click on the Reports folder and select Import SAS Package 

from the menu 

vi. Browse to 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\Pa

ckages and select the reports.spk file. 

vii. Select the radio button for All Objects and click Next 



 

 

viii. You should see a list of Reports in the window. Click Next and then Next 

again. 

ix. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

x. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp\ folder. Click Next. 

xi. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

xii. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log. 

xiii. Click Ok and then Finish. 
xiv. If required, selectively import metadata from the backup SPK (refer to Step 

1) for only those QRTs that were customized earlier and are not delivered 

in the hot fix. 

 
g. Import new reports_cp13.spk for the RMI Common Server component 

 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user 
 

ii. Click on the Folders tab 

iii. Navigate to the folder Reports under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1 

iv. Next, right-click on the Reports folder and select Import SAS Package 

from the menu 

v. Browse to 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\Pa

ckages and select the reports_cp13.spk file. 

vi. Select the radio button for All Objects and click Next 

vii. You should see a list of Reports in the window. Click Next and then Next 

again. 

viii. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

ix. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp\ folder. Click Next. 

x. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

xi. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log. 

xii. Click Ok and then Finish. 
 



 

 

h. Import updated system.spk for the RMI Common Server component 
 

i. Click on the Folders tab 

ii. Navigate to the folder System under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1 

iii. Right-click on the System folder and select Import SAS Package from the 

menu 

iv. Browse to 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\

Packages and select the system.spk file. 

v. Select the radio button for All Objects and click Next 
vi. You should see a list of STPs in the window. Click Next and then Next 

again. 

vii. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

viii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp\ folder. Click Next. 

ix. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

x. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log. 

xi. Click Ok and then Finish. 

xii. You should now see 

1. A new "Job name" parameter in the Parameters tab for the 

REPORT_OPTIONS STP if you had not installed F90004 or 

F90005. 

2. A new parameter for XBRL generation. 

3. A new "Verbose logging" parameter in the Parameters tab for the 

REPORT_OPTIONS STP 

 

 
i. Import updated utilities.spk for the RMI Common Server component 

 
i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user 

ii. Click on the folders tab 

iii. Navigate to the folder Utilities under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1 

iv. Depending on which hotfix was last installed, follow the steps in the 

appropriate section below followed by those in the Common Steps section 

to complete the import. 

 
F90006 (or more recent) installed 

 



 

 

v. Right-click on the folder named Data Management and click Delete 

vi. Next, right-click on the Utilities folder and select Import SAS Package 

from the menu 

vii. Browse to 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\

Packages and select the utilities.spk file. 

viii. Select the radio button for All Objects and click Next. You should see a list 

of STPs in the window. Click Next and then Next again. 

ix. Now, proceed with the Common Steps x. through xv. 

 
 
 
 

F90006 not installed 
 

v. Select the STPs listed below, right-click and click delete 

 

 ACCOUNTING_MEASURES 

 RE_J1 

 RE_J2  

 RE_J3 

 TP_E4 

 TP_E6 

 TP_E7A 

 TP_E7B 
 

The reason that these STPs need to be removed is to be able to consolidate 

them under a new Data Management folder (which will be installed from 

the utilities.spk files) and also because the .sas files they execute have been 

renamed. 

vi. Next, right-click on the Utilities folder and select Import SAS Package 

from the menu 

vii. Browse to 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\

Packages and select the utilities.spk file. 

viii. Select the radio button for All Objects and click Next. You should see a list 

of STPs in the window. Click Next and then Next again. 

ix. Now, proceed with the Common Steps x. through xv. 

 
Common Steps 

 
x. Ensure that you have the correct mappings for the SAS Application Servers. 

Click Next. 

xi. On this screen, map source code repositories between original and target 



 

 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp\ folder. Click Next. 

xii. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps. 

xiii. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log: 

xiv. Click Ok and then Finish. 

xv. You should now see the following STPs in the Utilities folder in a new 

"Data Management" folder containing data management jobs:  

 

 ACCOUNTING_MEASURES 

 BSC1 

 DMOTHER 

 LOSS_TRIANGLE 

 RE_J1 

 RE_J2  

 RE_J3  

 TP_E4  

 TP_E6 

 TP_E7A 

 TP_E7B 

 
 

Import updated rmi_etl_bridge_m1_hf13.spk for the RMI Solution Data Mart (SDM) 

ETL jobs 
 

v. Following is the summary of the newly added and modified jobs in this hot 

fix: 

 
Newly added jobs: 

 
RMI_INT_100_I_ACCOUNT_CREDIT_RISK_MITIGANT 

RMI_INT_100_I_CREDIT_FACILITY_CR_MITIGANT 

RMI_INT_100_I_EXPOSURE_CR_MITIGANT_RANK 
RMI_INT_100_I_FINANCIAL_POSITION_CR_MITIGANT 

RMI_INT_100_I_FRA_INSTRUMENT_LEG 

RMI_INT_100_I_RISK_FACTOR_X_RISK_FCTR_CURVE  
RMI_STG_210_CLOSED_ASSET_DERIVATIVE 
RMI_STG_210_CLOSED_ASSET_DERIVATIVE_TRADE 
RMI_STG_210_EXPOSURE_CRM_LINK  
RMI_STG_210_GL_ACCOUNT_BALANCE_LOOP 
RMI_STG_210_GL_BAL_SEGMENT_ATTR_VAR 

RMI_STG_210_GL_BALANCE_SEGMENT  



 

 

RMI_STG_210_PORTFOLIO 
RMI_STG_210_QUOTE_FUND 
RMI_STG_210_RATE_PARAM_GROUP_X_PARAMETER 

RMI_STG_210_RI_CONTRACT_COLLATERAL  
RMI_STG_210_SEGMENTED_GL_ACCOUNT_BALANCE 
RMI_STG_210_SEGMENTED_GL_ACCOUNT_BALANCE_LOOP 
RMI_STG_210_SUB_LEDGER RMI_STG_210_ENTITY_SYSTEM_IDENTITY 

RMI_STG_210_LINE_OF_BUSINESS_ASSOC 

RMI_STG_230_CAPITAL_ALLOCATION RMI_STG_230_CAPITAL_COST 
 

Modified Jobs: 
 

RMI_INT_100_I_ASSET_SGMNT_X_EXPOSURE 

RMI_INT_100_I_BOND_INSTRUMENT RMI_INT_100_I_COUNTERPARTY 

RMI_INT_100_I_CREDIT_CARD_ACCOUNT RMI_INT_100_I_CREDIT_FACILITY  
RMI_INT_100_I_CREDIT_RISK_MITIGANT 
RMI_INT_100_I_EXTERNAL_ORG RMI_INT_100_I_FINANCIAL_INSTRUMENT 

RMI_INT_100_I_FINANCIAL_POSITION 

RMI_INT_100_I_FX_FORWARD_QUOTE 

RMI_INT_100_I_FX_VOLATILITY_QUOTE 

RMI_INT_100_I_INT_RATE_VOLATILITY_QUOTE 

RMI_INT_100_I_INTEREST_RATE_QUOTE RMI_INT_100_I_PHYSICAL_ASSET 

RMI_INT_100_I_RISK_FACTOR  
RMI_INT_100_I_PORTFOLIO 
RMI_INT_100_I_REPO_INSTRUMENT 
RMI_INT_100_I_RISK_FACTOR_X_RISK_FCTR_CURV 

RMI_INT_100_I_SWAP_INSTRUMENT_LEG 

RMI_INT_100_I_COUNTERPARTY_CREDIT_ASSESSMENT 

RMI_INT_105_I_FINANCIAL_ACCOUNT 

RMI_INT_110_I_ACCT_POS_INST_FCLTY_APPEND 

RMI_INT_110_I_QUOTE_VOLATILITY  
RMI_STG_210_CEDED_LOSS  
RMI_STG_210_CLAIM_HISTORY  
RMI_STG_210_COUNTERPARTY_ASSOC 
RMI_STG_210_COVERED_PERILS 
RMI_STG_210_FINANCIAL_FUND  
RMI_STG_210_JOIN_CUSTOMERS 
RMI_STG_210_RI_CARRIER_X_RI_CONTRACT_SECTN 

RMI_STG_210_FUND_INSTRUMENT 

RMI_STG_210_GENERAL_INSURANCE_SUBJECT 

RMI_STG_210_GENERAL_INSURANCE_UOE 

RMI_STG_210_GL_ACCOUNT_ASSOC 
RMI_STG_210_GL_ACCOUNT_BALANCE 
RMI_STG_210_INSURANCE_SEGMENT 
RMI_STG_210_INSURED_ITEM_LOCATION 

RMI_STG_210_INTERNAL_ORG_ASSOC 

RMI_STG_210_LIFE_INSURANCE_POLICY  
RMI_STG_210_REINSURANCE_CONTRACT_SECTION 
RMI_STG_210_REINSURANCE_COVERAGE 
RMI_STG_210_RI_CARRIER_X_XL_LAYER 

RMI_STG_210_SECURITIZATION_POOL_MART RMI_STG_210_SUB_LEDGER 



 

 

RMI_STG_210_XL_LAYER RMI_STG_230_ASSET_SGMNT_X_EXPOSURE 

RMI_STG_230_CDO_INSTRUMENT RMI_STG_230_CASHFLOW_ACCOUNT 

RMI_STG_230_CASHFLOW_FRA RMI_STG_230_CASHFLOW_INSTRUMENT 

RMI_STG_230_CONVERSION_SCHEDULE 

RMI_STG_230_CONVERTIBLE_BOND_INSTRUMENT 

RMI_STG_230_COUNTERPARTY RMI_STG_230_COUNTERPARTY_RATINGS 

RMI_STG_230_CREDIT_RISK_MITIGANT 

RMI_STG_230_DISCRETE_CARRYING_COST 

RMI_STG_230_EMBEDDED_OPTIONS RMI_STG_230_FINANCIAL_CONTRACT 

RMI_STG_230_FINANCIAL_CONTRACT_ISSUE 

RMI_STG_230_FINANCIAL_EXPOSURE  
RMI_STG_230_GL_ACCOUNT  
RMI_STG_230_OPTION_INSTRUMENT RMI_STG_230_OPTION_SCHEDULE 
RMI_STG_230_QUOTE_FX  
RMI_STG_230_QUOTE_INDEX  
RMI_STG_230_QUOTE_IR 
RMI_STG_230_QUOTE_IR RMI_STG_230_QUOTE_VOLATILITY 

RMI_STG_230_QUOTE_VOLATILITY  
RMI_STG_230_REPO_INSTRUMENT 
RMI_STG_230_RF_CURVE_X_RF_GROUP RMI_STG_230_RISK_DRIVER 

RMI_STG_230_RISK_DRIVER_X_FIN_CONTR RMI_STG_230_RISK_FACTOR 

RMI_STG_230_RISK_FACTOR_CURVE RMI_STG_230_RISK_FACTOR_GROUP 

RMI_STG_230_RISK_FACTOR_X_RISK_FCTR_CURVE 

RMI_STG_230_SWAP_INSTRUMENT 
 
 
 

Excluded Jobs: 
 

RMI_INT_100_I_ASSET_SGMNT_X_EXPOSURE 
RMI_STG_210_REINSURANCE_TREATY 
RMI_STG_210_COUNTERPARTY_X_RI_TREATY  
RMI_STG_210_CEDED_EXPOSURE  
RMI_STG_210_RATE_PARAM_GROUP 
RMI_STG_230_ASSET_PORTFOLIO_SEGMENT 
RMI_STG_230_ASSET_SGMNT_X_EXPOSURE 

 

vi. If you already have existing RMI21.M1 ETL jobs, import the 

rmi_etl_bridge_m1_hf13.spk file from 

<SASHOME>\SASFoundation\9.2\SASRiskManagementForInsuranceMid 

Tier\2.1\ETL folder as explained below. 

 
Note: If RMI21.M1 ETL is not existing then first import rmi_etl_bridge.spk 

from the same location. 

 
A. Login to SAS DI Studio as the Administrator (sasadm) user 

B. Click on the Folders tab 

C. Navigate to the folder Products 



 

 

D. Right-click on the Products folder and select Import SAS Package 

from the menu 

E. Browse to \SASRiskManagementForInsuranceMidTier\2.1\ETL and 

select the rmi_etl_bridge_m1_hf13.spk file. 

F. Select the radio button for All Objects and click Next. 

G. Select the objects to Import and click Next 

H. Click Next on ‘About metadata connections’ Screen 

I. Select the target libraries that correspond to original libraries. Click 

Next 

J. Select the target tables that correspond to original tables. Click 

Next. 

K. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next. 

L. Review the Summary information and click Next. 

M. The next screen should show that the import was completed. Click 

the View Log button and scan the log for any errors. If the import 

was successful, you should see a message such as "The import 

process completed successfully" in the log 

N. Click Ok and then Finish. 
O. Execute the below code in DI Studio to delete the metadata for 

physically removed tables\columns. 

 

The code below will synchronize table\column metadata as per physical structures. 

(Assumption: All DDLs for current hot fix have been executed.) 

 

In DI Studio, start the code editor from “Tools” menu and execute below code with 

appropriate values of parameters. 
 

 
options  

   metaserver = "<metadata server>"  

   metauser = "<metadata user id>" 

   metapass = "<password for metadata user>" 

   metaport = <port number> 

   metaprotocol = bridge  

   metarepository = "Foundation"  

; 

proc metalib; 

   omr (library = "RMI Staging" repname = "Foundation");  

   update_rule (delete noadd); 

   report; 

run; 
 

 
 

4. If required, selectively import metadata from the backup SPK (refer to Step 1) for 

only those QRTs that were customized earlier and are not delivered in the hot fix. 
 
 

Follow the steps below to regenerate the Solution Data Mart (SDM): 
 
 

Run the following code to regenerate the Solution Data Mart: 



 

 

 
%rmiinit; 

%rmi_create_sdm(); 

 
Now run the following steps: 
 

1. Delete all user folders found in 

<SASCONFIG>\Lev1\AppData\SASRiskManagementForInsurance\2.1\data\userdata 
 

1. Login to Risk Management for Insurance 2.1 
 

2. Select File > Select Entity, choose an entity from the list, and click OK. 
 

3. Re-create the shared data mart for that entity. 
 

Select File > Manage Shared Data Mart from the menu and click Delete, then click 

Create in the same Manage Shared Data Mart window. 
 

4. Repeat steps 8 and 9 for each Entity. 
 

The above process will deploy the Solution Data Mart on your environment. By design, this 

deployment process will materialize the default configuration 

(“SOLVENCY2_LVL2_OCT2011”) set in the Solution data mart (level2 analytics with the 

CP11 reports).  

 

Alternatively, other configuration sets can be added by running the following code: 

 
%rmiinit; 

%rmi_add_new_configuration_set 

   (soln_data_mart_dir = <complete path to indata directory in your install> 

    , cards_file_dir = <complete path to where the configuration set cards file reside in your 

install> 

    , configuration_champion_flg = N 
   ); 

 

Example of indata path: 

<CONFIGDIR>\AppData\SASRiskManagementForInsurance\2.1\indata 

 

Example of cards_file_dir: 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\solution_data_mart\sampledata_

append_cp13 
 

Check the SAS log for successful execution of the preceding macro. 

 

 

Appendable configuration sets are: 

- SOLVENCY2_CP-13: Level2 analytics with CP13 reports  

- SOLVENCY2_LVL2_DIRR_ENABLED: Level2 analytics with CP11 QRT –  (limited 

pre-configured for DIRR) 

- SOLVENCY2_CP-13_DIRR_ENABLED: Level2 analytics with CP13 reports –  

(limited pre-configured for DIRR) 

- SOLVENCY2_14-209_14-210: pre-release configuration set for the EIOPA publication 

14\209 and 14\210 with CP13 reports (non-DIRR) 

 



 

 

 
 
 

G54011 for SAS Risk Reporting Repository 1.4_M1 

 
Data model changes have been made to the SAS Risk Reporting Repository. You must update 

the structures of the private RRR location and Shared location. 

 
There are different ways in which to apply the new structure. Please select one of the following 

methods that is applicable to your installation(s). 

 
NB: In this release of the SAS Risk Reporting Repository previously marked deprecated 

tables and\or columns have been removed from the model. The files for these structures may 

still exist on your installation due to the delivery mechanism; however, code has been added 

to ignore the pre-existing files when necessary. 

 
NB: If the post-installation tasks for F12006 have been applied, the structures of the Private 

locations will be automatically updated with the latest reportmart structure for the F120089 

post- installation tasks and the subsequent methods are not necessary for applying the data 

model changes to private RRR locations. The following methods can be applied to both the 

private and shared locations depending on the state of your installation. 

 
Updating via the provided sample data: 

 

If a given reportmart location has not been updated by another process, creating the shipped 

reportmart sample data in a given location will install the data model changes. 

 
The shipped sample data scripts already contain the updates in the RRR data model\formats. If 

you would like to utilize the shipped RMI sample data for the RRR without maintaining 

existing data, create the RRR sample data using the following steps. 

 
Note: The sample data creation script does not depend on the version of the original RRR that 

is being overwritten. This script will overwrite the existing data and data model. For example, 

if you are have the RRR 14 m1 version of the RRR and are installing the sixth RRR hotfix, by 

creating the shipped sample data you do not need to install the "sample data for the previous 

hotfix". The shipped sample data is a snapshot of the given version. 

 
Submit the following code with your installation specific information. (Note: This has changed 

from previous releases as you are now required to submit the rmiinit; prior to submitting the 

batch program.) 

 
options  

   metauser = "<username>"  

   metapass = "<password>"  

   metaserver = "<server_name>"  

   metaport = <port_number>  

   metarepository = "Foundation" 

; 

 



 

 

%rmiinit; 

%rmi_batch_create_rrr_sample_data 

   (ENTITY = MAIN 

    , USERNAME = <username> 

    /* Alternatively, use CONFIG_SET_ID = SOLVENCY2_CP-13 to pre-load CP-13 sample data */ 

    , CONFIG_SET_ID = SOLVENCY2_LVL2_OCT2011 

    , SCOPE = P 

   ); 

 
* If you need to install the reportmart sample data to the Global RRR with the sample data 

script, you must submit the following code with the additional information and changes: 

   
%let rrr_user = <username>; 
%let rrr_password = <Password>; 

 
options  

   metauser = "<username>"  

   metapass = "<password>"  

   metaserver = "<server_name>"  

   metaport = <port_number>  

   metarepository = "Foundation" 

; 

 

%rmiinit; 

%rmi_batch_create_rrr_sample_data 

   (ENTITY = MAIN 

    , USERNAME = <username> 

    /* Alternatively, use CONFIG_SET_ID = SOLVENCY2_CP-13 to pre-load CP-13 sample data */ 

    , CONFIG_SET_ID = SOLVENCY2_LVL2_OCT2011 

    , SCOPE = S 

   ); 

 

 

Note that to enable the production of the CP13 reports with sample data available in the 

RRR another CONFIG_SET_ID is required CONFIG_SET_ID = SOLVENCY2_CP13 

 
NOTE: It is not recommended that you use this process on the Global RRR unless you are 

absolutely certain of your specific installation needs. The script, as shown above, deletes the 

Global RRR and replaces the location with the new version of the RRR with the shipped sample 

data ONLY. All data in the Global location will be lost using this process. 

 
Updating an existing install with alter\migration scripts: 

 

If you have existing data in your reportmart and wish to only apply the data model changes, 

execute the specific alter scripts for your given installations: 

 
A. If the reportmart is the RRR14m1 version: execute %run_rrr14m1_to_rrr14m1hF. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14_to_m1rrr14hf9_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

 
Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\m1_to_hotfix9 

 
Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\m1_to_hotfix9 



 

 

 
B. If the reportmart is the RRR14m1hf1 version: execute %run_rrr14m1hf1_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf1_to_m1rrr14hf8_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

 
 

Win: 

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix1_to_hotfix9 

 
Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix1_to_hotfix9 

 
C. If the reportmart is the RRR14m1hf2 version: execute %run_rrr14m1hf2_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf2_to_m1rrr14hf9_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

 
Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix2_to_hotfix9 

Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix2_to_hotfix9 

 
D. If the reportmart is the RRR14m1hf3 version: execute %run_rrr14m1hf3_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf3_to_m1rrr14hf8_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

 
Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix3_to_hotfix9 

 
Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix3_to_hotfix9 

 
E. If the reportmart is the RRR14m1hf4 version: execute %run_rrr14m1hf4_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf4_to_m1rrr14hf8_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

 
Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix4_to_hotfix9 

 
Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix4_to_hotfix9 

 
F. If the reportmart is the RRR14m1hf5 version: execute %run_rrr14m1hf5_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 



 

 

m1rrr14hf5_to_m1rrr14hf8_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

 
Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix5_to_hotfix9 

 
 

Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix5_to_hotfix9 

 
G. If the reportmart is the RRR14m1hf6 version: execute %run_rrr14m1hf6_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf6_to_m1rrr14hf9_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix6_to_hotfix9 

 
Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix6_to_hotfix9 

 

 

H. If the reportmart is the RRR14m1hf7 version: execute %run_rrr14m1hf7_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf7_to_m1rrr14hf9_instructions.pdf that has been delivered with the alter scripts. 

These files will be typically located in the following directory: 

Win: 
<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9\hotfix7_to_hotfix9 

 
Unix: 
<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9\hotfix7_to_hotfix9 

 

I. If the reportmart is the RRR14m1hf8 version: execute %run_rrr14m1hf8_to_rrr14m1hf9. 

Follow the instructions to execute this alter script in the PDF document  

m1rrr14hf8_to_m1rrr14hf9_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory: 

  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_9 

 

Unix:  

<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_9 
 

J. If the reportmart is the RRR14m1hf9 version: execute %run_rrr14m1hf9_to_rrr14m1hf10. 

Follow the instructions to execute this alter script in the PDF document  

m1rrr14hf9_to_m1rrr14hf10_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory: 

  

Win:  



 

 

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_10 

 

Unix:  

<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_10 
 

K. If the reportmart is the RRR14m1hf10 version: execute %run_rrr14m1hf10_to_rrr14m1hf11. 

Follow the instructions to execute this alter script in the PDF document  

m1rrr14hf10_to_m1rrr14hf11_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory: 

  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_11 

 

Unix:  

<SASHOME>\SASFoundation\9.2\misc\rskrptmrtvrt\alterscripts\hotfix_11 

 

 

 
 

2. Installing a new reportmart using the ddls\createrrr.sas script: 

 
If you would like to create a new RRR with the new data model, follow the instructions for 

installing a clear RRR in the Installing and Configuring the SAS Risk Reporting Repository 

section in the SAS Risk Reporting Repository 1.4 Reference Guide, Second Edition. 

 
F92013 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1 

 
NONE 

 
F91013 for SAS Underwriting Risk Management for P&C Insurance Server 2.1_M1 

 

NONE 

 

G61010 for SAS Risk Management for Insurance Mid-Tier 2.1_M1 

 
If both F90006 and F90007 have been previously installed, the steps below can be skipped 

in their entirety. 

 
 
 

Re-build and Re-deploy Web Application 

 
This hot fix requires that the Web Application be rebuilt and redeployed. Use the following 

steps to perform this post-installation task: 

 
Step 1: Re-build Web Application 

 



 

 

In order for this step to execute correctly, the Metadata Server must be running. 

 
1.1 Invoke the SAS Deployment Manager 9.2 

 
From the SASDeploymentManager directory launch config.exe. 

SAS Deployment Manager is installed in the following default location: 

 
<SASHOME>\SASDeploymentManager\9.2 

 
1.2 Select a language in the Choose Language box 

1.3 Select Rebuild Web Applications 

 
1.4 Select Configuration Directory or Enter the Configuration Directory and Level that needs 

to be updated 

 
1.5 Specify Connection Information, including the sasadm User ID and Password 

 
1.6 Select Risk Management for Insurance as the Web Application to Rebuild 

 
1.7 Verify the information on the Summary screen and select Start 

 
1.8 Select Finish when the deployment is complete 

 

This process will update the Risk Management for Insurance ear in 

<SASCONFIGDIR>\Web\Staging. 

 

A backup of the original ear file will be placed in the directory below: 

<SASCONFIGDIR\Web\Staging\Backup 
 
 
 
 

Step 2: Re-deploy Web Applications 

 
Re-deploy the web applications based on the instructions for the web application server you 

are using. 

 
 
Re-start the application (or the application server) using your application server’s admin 

console. 

 
Before accessing the web application, empty the Temporary Internet files location on the 

client machine used to access the web application from. This is a precautionary measure to 

avoid problems due to caching of older files in the internet browser. 
 

 

Installing the Data Interface for the Risk Reporting Repository (RRR) 
 



 

 

 
Preliminary Note 
 
If you had previously installed an earlier version of the Data Interface for the Risk Reporting 
Repository, please delete all content under both the \Products\SAS Risk Management for 
Insurance\RMI 2.1M1\SAS Data Interface to RRR and \Products\SAS Risk Reporting Repository 
destination metadata folders in the SAS Management Console 
 

1. Locate the dirr_rrr_metadata.spk file in your install: in a typical install, the file resides 

under 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\Packages\rr

r 

2. Open SAS Data Integration Studio and navigate to the tab “Folders”.  Right-click the 

“Products” folder and import dirr_rrr_metadata.spk. 

3. Check the "Include access controls" box on the welcome screen of the Import SAS 

Package Wizard. Click next. 
4. Supply your SAS Application server when requested. Click next 

5. Accept the proposed “&RRR_PATH” when requested. Click next 
 

6. Review the changes and click Finish 

 

7. Locate the dirr_etl.spk file in your install: in a typical install, the file resides under 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasmisc\Config\Deployment\Packages\e

tl 

8. Open SAS Data Integration Studio and navigate to the tab “Folders”.  Right-click the 

“Products” folder and import dirr_etl.spk. 

9. Check the "Include access controls" box on the welcome screen of the Import SAS 

Package Wizard. Click next. 

10. Supply your SAS Application server when requested. Click next 

11. Supply your relevant folders for the libraries when requested. Click next 

12. Review the changes and click Finish 

 
 

 
 
 

This completes the installation of hot fix F90013 on Windows for x64. 


